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CHAP TER 1

YOUR FIRST 
ARDUINO SKETCH

Tools needed:

• Computer
• USB A to B cable

Parts needed:

• Arduino UNO (1)

It’s time to write your "rst Arduino sketch! A sketch is the 
Arduino term for the code that you upload to the device in 
order to make it behave how you want it to.

Here’s how this is going to go: I’m going to give you a series 
of steps to follow in order to make the sketch work. You will 
follow them. Once you’ve completed all of them and gotten 
this "rst project to behave how we want it to, we’ll double 
back, and I’ll explain the code line-by-line. Alright? All right. 
Let’s dive in.
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For this "rst sketch as well as the next one, I’m going to be 
a little more thorough in my explanation than I will be in 
later projects. It’s important to have a strong understanding 
of the basics before moving on to more complicated topics.

#e "rst project we’re going to complete is very simple—we 
are going to make a light on the Arduino blink on and o$. 
Essentially, the Arduino will act like a switch that we can 
control using some code.

#e little holes on top of the black bars lining the edges of the 
Arduino are called female header pins, or just pins for short. 
#ey are used to attach electronic circuitry to the Arduino 
by allowing wires to plug directly into them. Each of these 
pins has a number to identify it, which is written in white 
right next to the pin.

 

In this sketch, though, we won’t be attaching any wires to 
anything—instead, we’re going to work with the Arduino’s 
onboard LED, which is an LED light that is hard-wired to 
pin 13 on the Arduino (it’s labeled with an L on the surface 
of the Arduino board). Because it’s already connected to pin 
13, we won’t need to add any extra electronics.
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1. Open the Arduino desktop application. If you haven’t 
installed it yet, you can do so at https://www.arduino.cc/
en/Main/So&ware

2. #e window that opens should look something like this:

1. #is is called the Arduino Integrated Development Envi-
ronment (IDE) and is where you’ll be writing all of your 
Arduino sketches. If the window that opens doesn’t look 
something like this, or if no window opens at all, try the 
following to "x it.
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 – Click the “New” icon in the sketch window. To "nd it, 
"rst look at the checkmark button at the top le& of the 
window. #e “New” button is two buttons to the right 
of that one. Clicking the “New” button opens a brand 
new sketch with the default code already written.

 – If you can’t get the Arduino desktop application to 
work on your computer, register for an Arduino Cre-
ate account at https://store.arduino.cc/digital/create 
and install the plugin it asks you to. #is will allow 
you to use Arduino from your web browser. #e 
window looks a bit di$erent in Arduino Create, so it 
might be a bit harder to follow along, but all of the 
same buttons will be there in some form or other.

2. Type the following code into the sketch by hand. #e rea-
son you are typing it in by hand rather than copy-pasting 
it is that writing code e(ciently is di(cult and takes prac-
tice, mostly due to the fact that accidentally mistyping 
and breaking your code is easy to do and o&en di(cult 
to realize you’ve done, so it’s in your interest to begin 
practicing your code-writing accuracy right now. #is 
code is written in a programming language called C++, 
which is a popular and powerful language related to C 
and similar to Java in many ways.
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If you’d rather not type it in by hand, you can "nd all of the 
code used in this book at <web link>.

1. Go to File > Save (or press the button on the menu bar 
with an arrow pointing down) and save the sketch with 
the name “Blink” somewhere on your computer so you 
can easily "nd it again.
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1. A&er you’ve saved, click the “Verify” button at the top 
le& of the window (it looks like a checkmark) to verify 
the sketch.

1. #is will tell the computer to process your sketch to see 
if there are any errors. #e words “Compiling sketch…” 
should momentarily appear on the turquoise bar below 
the text area. If the bar below the text window turns 
orange, highlights one of the lines in red, and gives you 
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a strange error message in the place where it previously 
said, “compiling sketch,” follow these troubleshooting 
steps; if it turns turquoise and says, “Done compiling,” 
move on to step 5.

 – In the event of a syntax error, the IDE should high-
light a line of code in red. #is indicates that the error 
is on or adjacent to that line (for instance, sometimes 
the error is on the line above). #e error message that 
shows up written on the orange bar will provide a 
hint about what the error is. Sometimes the error 
message is complicated and hard to understand, but 
it is o&en useful in the event of a simple error.

 – Ninety-nine times out of 100, Arduino coding errors 
are due to the omission of a semicolon. If money 
and circumstances permit it, I suggest you tattoo a 
semicolon on the back of your dominant hand, and 
maybe your forehead as well, to remind you of this. 
In the event of a semicolon error, the error message 
will read something resembling “expected ‘;’ before 
‘}’ token” and highlight the line immediately a&er 
the one on which the semicolon is actually missing.

 – Make sure that every line you’ve typed in is exactly 
identical to the code typed in the image above. Com-
puter code can be very "nicky about accuracy.

2. If your window says, “Done compiling,” then it’s time 
to upload your sketch. Take your USB A to B cable, and 
plug the “B” end into your Arduino Uno. Hold o$ on 
connecting the “A” end to the computer for now.



3 8  · A R D U I N O F O R A R T I S T S
H o w  t o  C r e a t e  S t u n n i n g  M u l t i m e d i a  A r t  w i t h  E l e c t r o n i c s

1. Now we have to make sure the computer knows what 
kind of Arduino board it’s uploading to. Go to Tools > 
Board on the menu bar and select “Arduino Uno” from 
the rather lengthy list of possible boards.

1. For the last step before we upload our code, we need to 
connect the Arduino to the computer and tell the computer 
which USB port the Arduino is attached to. #e computer 
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will o&en connect to the correct port automatically, but let’s 
make sure just in case. First, go to Tools>Port and look at 
the options it gives you. Take note of these options, then 
close the menu and plug the “A” (normal-looking) end of 
the USB cable into a USB port on your computer. Note that 
the port names on your computer may be di$erent from 
the port names in this image.

1. Now go back to Tools > Port. Notice how a new option 
has popped up, probably with the words “Arduino Uno” 
in parentheses next to it? Select that one.
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1. Upload the sketch by clicking the “Upload” button, which 
is directly to the right of the “Verify” button on the top 
le& of the window and looks like an arrow pointing to 
the right.

1. When it’s done uploading, take a close look at the top of 
your Arduino board. #e LED should be blinking on for 
one second, o$ for one second, and then turning on and 
o$ again in a loop. If it is not doing so, refer to step 7c.

#e light should blink o$…
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And then on, and then o$ again.

Congratulations! You’ve completed your "rst Arduino proj-
ect! It doesn’t do all that much, of course, but the things that 
make this simple little blinking light work make up the core 
principles of all Arduino programming.

Almost all of the projects we’re going to work on a&er this 
"nd much of their foundation in this project. With that in 
mind, it’s very important that we spend enough time on this 
project to understand it fully.

understanding the Code
Let’s break it down line-by-line very, very carefully. #e "rst 
line reads:

// Blink

#is is what’s called a single-line comment. A comment 
allows the coder to leave notes to themselves and others, 
label sections of code, and indicate the function of various 
sections of code.
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To create a single-line comment, type two forward slashes 
one a&er the other. Everything on that line of code that 
appears a&er the two forward slashes will be grayed out by 
the IDE editor and ignored by the Arduino. In other words, 
anything you type in a comment a&er those two forward 
slashes have absolutely no e$ect on the code, no matter how 
profane or idiotic it is. (Keep in mind that if your comments 
are indeed profane or idiotic, they may still have an e$ect on 
anyone who reads your code.)

#e next three lines are another type of comment:

/*  Turns an LED on for one second, off 
for one second,

 *  and then repeats forever.

 */

#is is a multi-line comment. A multi-line comment func-
tions (or rather does not function at all) exactly the same as 
a single-line comment but can stretch across multiple lines. 
In order to create a multi-line comment, you have to open it 
with  /* and close it with  */. Anything a&er /* and before */, 
regardless of how many lines of code are between them, is 
ignored by the Arduino.

Note that when you begin typing a single line comment, the 
IDE automatically adds asterisks at the start of each new 
line until you close the comment to make it look pretty—
these are not necessary for the Arduino to recognize them 
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as comments. #e code would work exactly the same if it 
were written like this:

/*  Turns an LED on for one second, off for 
one second,

and then repeats forever.

*/

You could even move the “end comment” marker to the end 
of the second line, like so:

/*  Turns an LED on for one second, off for 
one second,

and then repeats forever. */

#ere’s a blank line a&er this comment (all blank lines are 
ignored by the Arduino), and then we have our "rst line of 
code that the Arduino will actually read. #is is where things 
start to get interesting. #e line reads:

int LED _ PIN = 13;

#is line creates, or rather, declares a variable. Variables are 
used to store values. However, any given variable can only 
store a certain type of value. What type of value it can store 
is determined when you declare the variable.

In this line, we declare a variable of the type int, name 
it LED_PIN, and assign it the value 13. When the Arduino 
reads this line of code, it creates a little space in its memory 
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to store int values and puts the number 13 in that space. 
For the remainder of the code, when it encounters the term 
LED_PIN, it will check to see what value is stored in the 
space it made for LED_PIN. In this sketch, that value will 
always be 13 because that’s the digital pin that the onboard 
LED is connected to.

#e int variable type is short for “integer” and indicates that 
only integer values can be stored inside the variable. An int 
variable can hold any integer value, an integer being a num-
ber with no decimal points, such as 5, 0, 28, or 10,000. #ere 
is a size limit on the int type, however—it can only be used 
to store integer values between -32,768 and 32,767.

#e second part of the statement, LED_PIN, is the name 
you’re choosing for the variable. #is can be almost anything, 
with a few restrictions. For example, you can’t start your 
variable names with numbers, and they can’t have any spaces 
or strange characters in them.

For variables that retain the same value for the entire dura-
tion of the code, the standard naming convention in C++, the 
programming language that Arduino programming is based 
on, is to make the name uppercase and to use underscores 
to separate words in the name.

You don’t have to follow standard variable naming conven-
tions if you don’t want to, but it can be helpful to get in the 
habit of using them, so the code in this book will use standard 
conventions for variable naming, as well as other formatting. 
Regardless of how you name your variables, make sure any 
name you choose to use is descriptive enough about what it 
stores to allow you or someone else who might be reading 
your code to "gure out what it’s used for easily.
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A&er LED_PIN, we have a single equals sign. When the Ardu-
ino sees an equals sign in the code, it knows that whatever 
number is on the right side of the equals is the number that 
should be stored in the variable named on the le& side.

Finally, we have the value we’re assigning to the variable, 
13, followed by a semicolon (“;”). Do not forget the semi-
colon. Ninety-nine percent of all programming errors 
can be traced to forgotten semicolons. The semicolon 
indicates to the compiler that a given statement has come 
to a close.

In summary, if you read the line

int LED _ PIN = 13;

as a sentence, it really just means “#e integer called LED_
PIN is equal to thirteen.”

Next, let’s "rst look at this entire block of code. A block is 
a portion of code bounded by “curly braces” (the ‘{‘ and ‘}’ 
characters, respectively) that functions as a complete unit.

void setup() {

// put your setup code here, to run once:  

// set the LED pin to be an output

 pinMode(LED _ PIN, OUTPUT);

}
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Note that the information inside the block of code is 
indented—this is another formatting convention that the 
Arduino IDE encourages.

#is entire block of code is called the setup() function. Every 
single Arduino sketch must have a setup() function. #e role 
of setup() is to run code that initializes various things in the 
sketch. It runs all of the code between its open and closed 
“curly braces” one single time at the very beginning of the 
sketch and then never again until the Arduino is restarted. 
In its most basic form, the setup() function looks like this:

void setup() {

}

#e setup() function above has nothing between its curly 
braces and thus does absolutely nothing. However, even if 
it does nothing, every sketch must have a setup() function, 
and every setup() function must look exactly as shown above, 
with a “void” initializer, the word “setup()” with the paren-
theses, and open and closed curly braces. Code may option-
ally go between the two curly braces, and there is almost 
always something between them.

In our code, we have three things between these brackets. 
#e "rst two are just more comments.

// put your setup code here, to run once:

// set the LED pin to be an output
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However, the last line is something new:

pinMode(LED _ PIN, OUTPUT);

#is is something called a function. #is particular function 
is called pinMode() and is built into the Arduino so&ware. 
Functions are designed to, well, perform a speci"c function, 
and most have parameters that give them the information 
required to do their job. In the Arduino IDE, function names 
typically appear in orange, with the exception of setup()and 
loop(), which are special.

#e function of pinMode() is basically to change one of the 
Arduino’s settings. #e Arduino UNO has an onboard LED 
that is connected to pin 13. We want to be able to turn this 
LED on and o$ by controlling whether power is moving 
through pin 13 or not. To do this, we must set the “mode” 
of pin 13 to OUTPUT. pinMode() allows us to set any pin 
to either the INPUT or OUTPUT mode, provided we tell it 
which pin to set the mode of and what mode to set it to. #us, 
we give it the parameters by writing them in the parentheses 
that come a&er the function name like so:

pinMode(pin#, INPUT/OUTPUT);

In this case, the pin# is 13, and the mode is OUTPUT. How-
ever, we’ve already stored the pin number in the variable 
LED_PIN, so we can plug in the parameters as:

pinMode(LED _ PIN, OUTPUT);
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#e "nal block of code is called the loop() function:

void loop() {

// put your main code here, to run repeatedly:

 digitalWrite(LED _ PIN, HIGH); // turn LED on

delay(1000); // do nothing for 1000 millisec-
onds (1 second)

digitalWrite(LED _ PIN, LOW); // turn LED off

delay(1000); // do nothing for 1000 millisec-
onds (1 second)

}

#e loop() function is another special function, like setup(), 
with the primary di$erence being that loop() will run all of 
the code between the curly braces from top to bottom, start at 
the top again once it reaches the bottom, and continue to loop 
this pattern until the Arduino is turned o$. #is is where 
most of the interesting parts of Arduino code can be found.

A&er the comment at the top of the block, we see a new 
function, digitalWrite(), as well as a single-line comment 
in a location we haven’t seen one in before.

digitalWrite(LED _ PIN, HIGH); // turn LED on

Single-line comments (or multi-line comments, for that mat-
ter) can begin anywhere on any line, even when that same 
line has code on it. Just keep in mind that anything at all, 
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code or otherwise, that is written to the right of the slashes 
will be ignored by the compiler.

digitalWrite() is another function much like 
pinMode, but instead of changing a setting, 
it controls whether one of the Arduino’s pins 
is high or low. Its parameters are:

digitalWrite(pin#, LOW/HIGH)

#e "rst parameter, the pin#, is the pin you want to control 
the output of. #e second parameter is the output power 
level you want to set that pin to. Setting this parameter to 
LOW makes the pin output zero volts. Setting it to HIGH 
makes it output "ve volts (or whatever the highest voltage 
your board can output is). If we have a component, such as 
an LED, connected to that same pin, this allows us to control 
whether power is /owing through it and thus whether the 
LED is operational.

#erefore, the statement 

digitalWrite(LED _ PIN, HIGH); // turn LED on

turns on the onboard LED connected to pin 13 (LED_PIN) 
by applying 5V of power across it.

#e next line is as follows:

delay(1000); // do nothing for 1000 millisec-
onds (1 second)

#e third and "nal function of this sketch, delay(), is even 
simpler than the "rst two. delay() causes the Arduino to 
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pause everything it’s doing and freeze for a given number of 
milliseconds (1 millisecond = 1/1000 second).

Why milliseconds? Milliseconds provide a higher degree of 
precision than seconds, and it’s a unit of time that comes in 
very handy when using Arduino and electronics, which can 
process data many thousands of times faster than a human 
can. In fact, there is no variant of the delay() function built 
into Arduino coding that lets you use a larger unit of time 
than the millisecond, although there is one that lets you use 
a smaller unit of time. delay() has a single parameter: the 
number of milliseconds to delay everything for.

delay(milliseconds)

In our case, the parameter is 1000, which means that when 
the Arduino reaches this line of code, it will bring everything 
to a halt for 1000 milliseconds (AKA 1 second).

#e last two lines of code inside the block look very similar 
to the "rst two:

digitalWrite(LED _ PIN, LOW); // turn LED off

delay(1000); // do nothing for 1000 milliseconds 
(1 second)

#e only di$erence this time around is that instead of the 
second parameter for digitalWrite() being set to HIGH, it is 
now LOW, meaning that the Arduino will set the LED_PIN 
(pin 10) to LOW (0V), which will turn the LED o$. It will 
then do nothing for a second. Once the Arduino has executed 
these "nal two lines, it will hit the end of the loop() function, 
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as indicated by the curly brace at the end of the line of code, 
then go back to the top of the loop() and do everything all 
over again.

#at was a lot to take in, so let me rewrite all of the code we 
just went through in English, so it makes a little more sense. 
#is will be in the form that the compiler will read the code 
in, so I’ll skip all the comments.

An integer-type variable with the name LED _
PIN now has the value 13.

Begin the setup function:

LED _ PIN, which is pin 13, is an output.

End the setup function.

Begin the loop function:

Set LED _ PIN (pin 13) to HIGH (5V).

Do nothing for 1000 milliseconds (1 second).

Set LED _ PIN (pin 13) to HIGH (5V).

Do nothing for 1000 milliseconds (1 second).

Go back to the beginning of the loop function.

That’s really it. The code is read line by line, from top 
to bottom, executing each command in chronological 
order. The ultimate function of this code is found in the 
loop function:
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1. Set LED_PIN to HIGH, which turns on the LED

2. Do nothing for one second, during which time the LED 
remains on

3. Set LED_PIN to LOW, which turns o$ the LED

4. Do nothing for one second, during which time the LED 
remains o$

5. Go back to step one.

#is process you’ve just undergone—writing a series of com-
mands to tell a computer or Arduino exactly what you want 
it to do—is all coding really is. If you can understand this 
sketch, you’re more than prepared to move on ahead.

extended learning

Now that you understand how this sketch works, it might be 
helpful and fun to play around with the code you’ve already 
written to get used to writing your own code. Here are several 
simple ways you can modify the code we wrote in this project 
to make it work in new and interesting ways.

changing the Length of the deLay

What if you want your LED to blink faster? Simple: change 
the number in the delay() functions. #e smaller the delay, 
the less time will pass between the light blinking on and 
blinking o$. #e larger the delay, the more time will pass 
between the light blinking on and blinking o$.

To add an interesting twist, you could give each of the delay() 
functions a di$erent parameter. If you make the delay a&er 
the light is turned on shorter than the delay a&er the light is 
turned o$, what happens?
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#e answer is that it will turn on for a brief moment and then 
turn o$ for longer. #e light will become just a little blip. Do 
the opposite, making the “on” delay longer than the “o$” 
delay, and the light will /icker o$ occasionally.

Try changing the delay values, clicking the “verify” button 
(the check mark), and uploading your new code to the Ardu-
ino to see what happens.

changing the BLink Pattern

We’ve already written a sketch that turns the LED on, turns 
it o$, and repeats. But what if you wanted a di$erent pattern? 
What if you wanted to turn it on for a long time, turn it o$ 
for a long time, then rapidly turn it on and o$ before going 
back to the beginning?

If you want to increase the complexity of your blink pattern, 
you need to add additional digitalWrite() and delay() func-
tions, with the appropriate parameters, to loop(). Everything 
inside the loop() will repeat, so as long as the code inside it is 
valid, it can be as long and complicated as you want it to be.


